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Main Meeting, July 15, Sunday
Special Recognition Meeting. Come and meet and listen to original members, founders, of the NOCCC. Refreshments
and a raffle of unique items, coveted by all, will be available.

Big prizes for our July raffles:
Paid drawing:
Plantronics Bluetooth stereo headset
SUMA Car 6in1 MP3 Player/FM Transmitter
Memorex DVD-4 50pk spindel
Iogear USB SD/MicroSD/MMC Rdr/Writer
Antec Basic Laptop cooler

Members drawing:
Patriot 32GB USB 3.0 Flash Drive
SUMA Car 6in1 MP3 Player/FM Transmitter
Energizer USB wall charger 5W
Memorex DVD-4 50pk spindel
Iogear USB SD/MicroSD/MMC Rdr/Writer
Antec Basic Laptop cooler
Wear your badge to get a free ticket.

June winners’pix (Click Here). NO Consignment Table and E-Waste Collection in July.

Special Interest Groups (SIGs) & Main Meeting
9:00 a.m.
Linux for Desktop Users
………....................Science 131
Topics about the Linux operating system.
Beginner’s Qs here.
Visual Programming .. ……………………..
….Science 111
Visual Basic, Visual BasicScript, Visual C++ and
Visual J++.
Laptops, Smartphones, & Social Media
......Science 109
Social Networking & any computer-related
topics you want to discuss.
Beginners Digital Photography
……..........Science 131A
Topics about digital photography.
Microsoft Word, Excel, and Outlook…….…
Science 306
Three parts of the Microsoft Office Suite plus Open
Office.
Reviews & Consignment Tables, Coffee & Donuts:
Irvine Hall Lobby

10:30 a.m.
Beginners PC Q & A ......................................
Irvine Hall
Building your own PC and other topics!
Linux
Administration………………...............Science
131
More topics about the Linux operating system.
Access/Excel VBA……………………….……
Science 306
Access & Excel VBA code.
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10:30 a.m.
Advanced Digital Photography…………...……..Science 131A
Demonstrations of a variety of useful photographic tools/accessories and the Canon S100 camera
.
Understanding Operating Systems…………........Science 111
Help with DOS, Windows, OS/2, etc.
Mobile Computing.... ……..................................Science 109
This SIG discusses mobile devices.

12:00 Noon
PIG SIG………………………….……....…..Hashinger Courtyard
Microsoft Access …………........................…….…Science 306
Database applications and more.

12:30 p.m.
Advanced PC Q & A……………………..........…….…Irvine Hall
PC hardware & software topics and the Internet. Members Q & A
each other.

1:30 p.m. Special Main Meeting…….…..Irvine Hall
Special Recognition Meeting - General Public and Members
welcome

Founding NOCCC members will speak.
Find out how it was in the olden days.
Firm Future Meeting Dates in 2012 and 2013:
July 15th - 3rd Sunday, August 12th - 2nd Sunday, September
2nd, October 14th - 2nd Sunday, November 4th, December 2nd,
January 6th, 2013, February 3rd, 2013, March 3rd, 2013, April
7th, 2013, May 5th, 2013.
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Publication Chairman - Oversees publication tasks and converts the Orange Bytes
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Editor - Edits, composes, and makes final selections of the articles in the newsletter.
Rudy Lauterbach.....................714-529-5730............... editor@noccc.org
Associate Editor/Production - Receives articles from the editor and proofreads newsletter.
open............................................................................ editor@noccc.org
Circulation - Oversees mailing and distribution of the newsletter.
Richard Miller.......................(714) 309-1504................. rrrmil@gmail.com
Reviews Editor - Communicates with the vendors and members who evaluate products and
write reviews. Makes sure members meet deadlines. Sends a copy of the newsletter to
vendors of products we review.
open............................................................................ reviews@noccc.org
Copy Editor - Does final proof reading of the newsletter for typos and misspellings.
All sentient members ...................................................... editor@noccc.org
VOLUNTEERS NEEDED
The following positions are available:
Social Media Contacts – Maintain and write articles for the newsletter.
Contributing Editors - Write articles for the newsletter.
Commercial Advertising - Obtains ads from vendors for the newsletter.
Classified Advertising - Obtains computer-related, non-commercial ads for the newsletter
free to NOCCC members

Celebrating 36 years of
"Friends Helping Friends"
President’s Message
For July 2012
by Dr. Patricia Adelekan, DTM, CTA
North Orange County Computer Club (NOCCC)
Since my last President’s Message, so much has happened. First, we had the Special Executive
Board Meeting, on Thursday, June 27, 2012. It was a great success with 10 of the 14 Board
members present and five guests. Two of the guests entertained us with stories about how NOCCC
got started and the pride and diligence they had “making it happen.”
Our first special guest was Member No. 2 Larry McDavid—one of the four founders. He wrote the original bylaws, and had with him
at the meeting early issues of the Orange Bytes Newsletter from its inception, April 1976.
The second guest was Bruce Brown, the first Editor of the Orange Bytes. We were moved as we listened in awe about what they had
to show and tell. They will be at the Appreciation and Recognition Ceremony on Sunday, July 15, 2012 at 1:30 p.m. You won’t want
to miss them; shake their hands; take photographs with them, get their autographs and learn “from the horse’s mouth" about the
beginnings of our fantastic historical organization.
Secondly, my research has confirmed that the North Orange County Computer Club is the 2nd oldest continuously running computer
club in the world. The first to start was the Computer Club of New Jersey. You can Goggle it.
Thirdly, at the meeting, we deliberated over many issues and matters. I will be talking and writing about them as time goes by.
However, we encourage all members to attend the Board meetings generally held the Monday after a General Meeting; and all
members and non-members are encouraged to visit our website (noccc.org) often for updates on events, ideas, and issues. We
sincerely welcome your comments, questions, input and articles.
Fourthly, over the past two weeks, I have talked to over 100 people who had or have connections with NOCCC. Indeed, I have
received encouraging feed back, warmth, and information. I want to thank everyone for your support, sharing, and insight. I feel that
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ours is an organization of “Friends Helping Friends.” At the special celebration you will learn about the origin of this club motto.
Next, we have joined the organization for non-profits in Orange County called One OC (the former Volunteer Center of Orange
County). As many of you know, NOCCC is a 501 (c)(3) not-for-profit organization. There are many benefits to belonging to such an
organization – including securing volunteers to help us with some of our tasks and responsibilities. At the next Board Meeting, on
Monday, July 16, 2012, our guest Speaker will be Yolanda Origel from One OC. All are invited to come and listen to her 15-20
minute presentation and to ask questions. In the meantime why not visit their website: OneOC.org.
To anyone who is scheduled to speak at the celebration or who will receive a certification of Appreciation (over 100 of you), please
prepare your speech and look presentable because Frederick Burbond, an M.A. Film Graduate from the Dodge College of Film and
Media Arts at Chapman University will be present to video this historical event.
Also, plan to visit one of the Special Interest Groups (SIGS) in the morning (visit our website noccc.org for titles and times of the
SIGs -- and parking.) Cake and other refreshments will be served in the early afternoon.
Surely, as we move into the near future, my desire for NOCCC is to continue with the slogan “Friends Helping Friends” -- In a
positive and supportive learning environment which aims to embrace:
• Members, guests, volunteers and acquaintances from multi-cultures & multi-generations;
• Emerging new technologies and products;
• More knowledge about hardware and software;
• Concept of Cloud computing;
• The field of “Applications – Apps” in today’s technology world;
• Shared knowledge; and
• A Consortium of Computer and Technical Organizations/Clubs from around the globe.
Finally, it is my Dream that NOCCC will last another 36 years and beyond. And that some of the former members will rejoin and
partner with us as we embark upon another New Era of Greatness in Technology. So, bring your checkbooks to the celebration and
join or rejoin NOCCC. The public is welcomed—especially from ALL generations.
Looking forward to seeing and meeting you at the Appreciation and Recognition Event -- this coming Sunday, July 15, 2012 at 1:30
p.m. -- or at my SIG (9:00 AM, Science Bldg., 109) – at Chapman University.
Dr. Patricia Adelekan, President, NOCCC
714-628-9844
Area E1 Governor 2011/12 Toastmaster of the Year 2010/11
Inner Strength Toastmasters, ESL Toastmasters,
Golden Seniors-on-the-Move, Tech Tools Toastmasters No. 1,
Career Builders TM Club of Crystal Cathedral

Special Executive Board Meeting
A special Board Meeting was held on June 27, 2012. We had
about 12 attendees. What a pleasure it was to have this Special
Executive Board Meeting and to have one of the original
founders of the Club (Larry McDavid #2) with us. He shared the
story of how the North Orange County Computer Club (NOCCC)
got started – a story that will be told at the “Honor the History
and Heroes” Reception on July 15 at the Main Meeting of the
NOCCC from 1:30 – 3:30 p.m.
The Special Executive Meeting was held at the home of Dr.
Patricia Adelekan, the new President of NOCCC. At the meeting
also was Bruce Brown (#28 -- the first editor the Orange Bytes
newsletter). His story was equally compelling and inspiring. They
both will be at the Celebration on July 15. So, you do not want to
miss it, and be sure to invite your family, friends and others.
They will talk about their NOCCC journey and where they feel
NOCCC will go from here.
We shall be recalling and writing history – the Legacies that all
NOCCC members (past and present) have built for future
generations.

Pictured above L to R: John Heenan, Tresurer;
Larry   McDavid, Founder; Ben Lochtenbergh,
Director; Dr.   Patricia Adelekan, President;
Richard Miller, Director;   Rudy Lauterbach, Editor;
Dr. Don Armstrong, Vice   President. Photo credit:

Member Lyle Holmes.
At the event, we shall present Certificates of Appreciation and
Recognition to many Volunteers, SIG leaders, Executive Board members, Founders and others who have made a difference. We shall
also be inducting the new officers recently elected on June 3, 2012.
Let us keep in mind that North Orange County Computer Club (NOCCC) is an education non-profit organization, which began in
April 1976 to help people embrace the new technology at that time. It has served thousands of people over the years and is still
serving. We are trying to find the niche we can fill in today’s society. All suggestions are welcomed.
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So, please don’t miss this important event; you and your children and grandchildren, and friends, etc. can get autographs and to take
photos with many of these pioneers and history makers.
I look forward to meeting you there – at the great event.
Dr. Pat Adelekan

Photos from the Special Recognition Meeting

Photos: John Krill and Rudy Lauterbach

President's Report on the Special Recognition Meeting, July 21, 2012
What an interesting meeting!!!
There were over 70 attendees at the Appreciation Event.
“I learned a lot about the North Orange County Computer Club (NOCCC) and its beginnings and founders,” said Linda Jaeckels, a
new member who gave an inspirational message about “Change” at the close.
The meeting began on time with a positive inspirational message by new member James Burnell, followed by four pioneers of the
North Orange County Computer Club (NOCCC). The first speaker was NOCCC member #2, Larry McDavid, who told how, in early
1976, some computer enthusiasts would car-pool to Los Angeles from Orange County to “ jammed-pack” computer meetings. Then,
one day, one of the car-poolers, said, “why do we have to travel so far"?
If anyone among you (in the car) would like to start our own club in Orange County, let me know. Thus, the club was started. Larry
McDavid said that there were four founders: Lorin Mohler (# 1), the first President; Larry McDavid (#2), himself and the drafter of
the first by-laws of the club; Tracy Lenocker (#23), and #38, Gary Dickinson.
And, in his speech, Larry further narrated that within months they had collected 49 charter members. He also had slides of the first
computers – in those days (1976).
Following Larry McDavid, Bruce Brown, the first Editor of the Orange Bytes; Jim Sanders, Member No. 19 and immediate past
Presiden of NOCCC; Gerry Resch, Member, NOCCC Director, and co-owner of Omni Technics (eWaste), James MacAuliff,
NOCCC Member No. 115, and Gordon Eng (#6101) spoke. All spoke about various historical aspects of NOCCC. All of the
presentations were enlightening and shed some light on the beginning and development of this historical, 36-year-old NOCCC.
The history lesson was followed an apology for not having the Certificates of Appreciation ready for distribution during this
Appreciation Day Celebration – and that they would be given at a later date.
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Next, the former board members were asked to stand for an applause of appreciation for their volunteer service to NOCCC during the
2011-2012 season. Then, Ken Maxfield, a polished Toastmaster, conducted a creative Induction Ceremony for the incoming 20122013 Board (4 Officers and 8 Board Members). He reminded them of their duties as Board members and then asked the audience to
stand and promise to support the board in fulfilling the goals and objectives of NOCCC. It was fun – I did not get a cigar, though.
Finally, Linda Jaeckels, a new member of NOCCC, presented an original inspiration speech entitlted "Change" to close out the Main
Meeting.
To add to the excitement of the day, young people present were interviewed about their interests in computers. Nicholas Schofield
said he might like to see a “Games” SIG. We also recognized the following four members who represent “ generations” that have
interests in computers: 1) Mr. Jim Goda, a one-time President of NOCCC; his daughter, Sharon Schofield; and her brother, Nicholas
Schofield; (2) Ed Koran, his son and daughter; and their children (his grandchildren); (3) Bob Dickson, his son and grandson; and Dr.
Patricia Adelekan, new President (her son Aderemi and his daughter Sade). Each of these families will receive a certificate of
Recognition as Generational Users. I personally encourage other NOCCC families and their off-spring to let us know what they are
doing (as family members of NOCCC members) in the computer field; so I can write about them, too—and to take a few photos.
The Main Meeting went well according to NOCCC members and guests. “ We shall do something like that more often,” said Tia
Christian, a Board Member who was in charge of food and a PC Sig.
The next Main Meeting will be August 12, 2012 at 2:00 p.m. In Irving Hall, Chapman University. The presenter will be Mr. Marty
Lash, Channel Marketing Manager, View Sonic Products.
We shall honor a few more people at the Main Meeting, also.
Dr. Pat Adelekan

NOCCC Elections
Elections were held at the June 3rd main meeting.
The current Officer Corps and Board of Directors is shown below.
Formal installations will take place in the July meeting.
While mostly taken from the Bylaws, the summary of duties below is nearly all-inclusive.

Current Complement of NOCCC Officials
President:
Vice President:
Treasurer:
Secretary:

Dr. Patricia Adelekan
Dr. Don Armstrong
John Heenan
Steven Breitbart

Director:
Director:
Director:
Director:
Director:
Director:
Director:
Director:
Director:

Jim Sanders
Gordon E. Strickland Jr.
Richard Miller
Gerry Resch
Ben Lochtenbergh
Dallas Hazleton
Tia Christian
Larry Klees
Rudy Lauterbach

    President and Vice President

See the table below for phone numbers and email addresses.

NOCCC Executive Board Descriptions
“The NOCCC Executive Board “subject to the limitations of those bylaws, shall debate, establish, amend, and update the policies for
all the affairs and business of the NOCCC.”
“The Board shall concern itself with the disbursement of all NOCCC moneys. The Board shall consider the budget and such
additional expenditure requests as are submitted by the president, and shall authorize such expenditures as it considers wise and
appropriate.” The NOCCC Executive Board consists of four officers, eight elected directors, and ex-officio members. There are four
officers of the club: President, Vice-President, Secretary, and Treasurer.
Duties of the President

Represent the NOCCC to the community as the chief executive officer.
Set the agenda for and presides at all general meetings of the club.
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Set the agenda for and presides at all meetings of the NOCCC Executive Board.
Appoint members to chair all standing and special committees and appointed positions.
Receive, on behalf of the NOCCC, all contributions to the club.
Duties of the Vice President

Assume special duties as may be directed by the president.
Duties of the Secretary

Establish and maintain a record of all NOCCC correspondence, and attend to correspondence as directed by the president of the
Executive Board.
Duties of the Treasurer

Receive and deposit into the NOCCC accounts all moneys received.
Establish and maintain a record of all real or personal property acquired by the NOCCC and cause said property to be permanently
identified as property of the NOCCC.
Suggest, if appropriate, to the Executive Board that an audit be made and reported to the general membership.
Elected Directors
The eight elected directors are on the Executive Board and, along with the four officers, address any issue that comes before the Board.
Ex-officio members of the Executive Board
Ex-officio members of the Executive Board are the immediate past president, editor of the club newsletter and the webmaster. The President
appoints the editor and webmaster.
Other Appointed Positions
These positions are Membership Chairman, Reviews Editor, Public Relations, Business Solicitations/Lecture Series, Classified Advertising
for Members, Commercial Advertising, Webmaster and Programs/Speakers Coordinator. Contact the current club President if you are
interested in any of these positions. We can then include your name in the next issue of the Orange Bytes.

Membership Benefits
As a valued member, we bring you a selection of discounts and offers as part of the entire “Benefit of Belonging.” (Caveat: we
are unable to endorse these companies, but make these offers available as a service to our members.)

User Group Offers - Software and Hardware

User Group Relations – You can now order the latest release of Acronis True Image 2012 for only $25 (download) or $25 plus
S&H (on a CD). This top-rated backup utility has many new features and will work with Windows 7. Use the following link for
special pricing for user group members: Acronis.
Techsmith You can get SnagIt 11, an outstanding screen capture program, and Camtasia Studio 7, to quickly record, edit and
publish multimedia demos and presentations, bundle for $269, an $81 savings: https://store.techsmith.com/government.asp. You
can download SnagIt 10 alone for $42.95.
Books and Magazines -Pearson Education Products - including Prentice Hall Professional, Addison-Wesley Professional, IBM Press, Exam Cram, Que
Publishing, and Cisco Press. Get 35% off list price by purchasing directly from the publisher combo site: www.informit.com/>
Sign in or create an account. Enter the membership code “USERGROUP” (all caps). Select your items and check out. You are
required to register and apply the code once, but you must be logged in to receive the special pricing.
O’Reilly Books 40% off all books and videos from O’Reilly, Microsoft Press, Pragmatic Bookshelf, and SitePoint, or 50 % off
books you purchase directly from O’Reilly. Just use code DSUG when ordering online, www.oreilly.com/store/, or by phone,
(800) 998-9938. Free ground shipping on orders $29.95 or more in the US. If for any reason you are not completely satisfied with
your purchase, you can return it to O’Reilly and get your money back; see www.oreilly.com/oreilly/cs/guarantee. A return
shipping label is included with every direct purchase and directions are posted online in case you misplace it.
Peachpit Press Books Discount - Get 35% off by joining the Peachpit Club. Use the following hyperlink to sign up:
http://memberservices.informit.com/my_account/login.aspx?partner=52 to sign up as a member. User group members should note
that once you have become a Peachpit Club member, you might use your user group coupon code ON TOP of the permanent
savings you earn as a member of the club. Just log into the site before you make a purchase to ensure this permanent discount will
be in effect, and then enter coupon code UE-23AA-PEUF (case-sensitive) at checkout! This coupon code is an exclusive offer
that may not be used in conjunction with any other coupon codes. The offer applies to all titles at peachpit.com including New
Riders, Macromedia Press, Adobe Press, and Peachpit.
Free Internet Libraries - Upon retiring from college teaching/administration, Walter Antoniotti began developing Free Internet
Libraries for students, teachers, and professionals. http://www.businessbookmall.com/Free Internet Libraries.htm. Of special
interest to PC users are these free computer libraries: Free Business Software: Business Software Internet Library.htm
Free Software Tutorials: http://www.businessbookmall.com/Software Tutorials Internet Library.htm
Excel Internet Library: http://www.businessbookmall.com/Microsoft _Excel_Directions_For_Beginners.htm

July 15th, 2012 - Main Meeting Report
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By Steven Breitbart, NOCCC, Secretary
Club Business
This was a meeting to honor and recognize founding members of NOCCC. More in the President's Message.
See some pictures - click here.
Main Speakers
Larry McDavid, Bruce Brown, and others.
Steven M. Breitbart, P.E.
h) (714) 486-3070
c) (714) 421-1118

THE July 15, 2012, MEETING RAFFLE WINNERS

Nick Schofield

Don Armstrong

Frederic Fuller

John Szary

Martin LaRocque

Nick Schofield

Kaz Adachi

Frederick Fuller

Don Armstrong

Ed Koran

Bob van Horn

Nick Schofield

Terry Dickson

Linda Jaeckels

Larry McDavid

Photos by John Krill

The prizes shown are one of the following:
Plantronics Bluetooth stereo headset, SUMA Car 6-in-1 MP3 Player/FM Transmitter, Memorex DVD4 50 pk
spindel, IOgear USB SD/MicroSD/MMC Rdr/Writer, Antec Basic Laptop Cooler, Patriot 32 GB USB
3.0 Flash
Drive, Energiser USB wall charger 5W, (When you buy mass quantities of tickets, you may win twice.)

THE June, 2012, MEETING RAFFLE WINNERS
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Dallas Hazelton

Dennis Martin

Robert van Horn

Bill van Horn

Don Armstrong

Bob Dickson

Terry Dickson

Pat Adelekan

Dallas Hazelton

Pat Adelekan

Martin LaRocque

Robert VanHorn

Gerry Resch
Photos by John Krill

The prizes shown are one of the following:
Canon Pixma iP2702 inkjet printer, Pny 32GB USB Flash Drive, TDK DVD+R 75 PAQ,
HP CD_R 52x 50pk, LED Keychain. (When you buy mass quantities of tickets, you may win twice.)

PREVIOUS RAFFLE WINNERS

John Krill

Gordon Strickland

Dennis Martin

Jim Sanders

Gordon Strickland

Ron Hallet

Dallas Hazelton

Steven Breitbart
Photos by John Krill

The prizes shown are one of the following:
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Speakers, System Utilities software, LED Key Ring Light, Web Easy 8 software, PC Tools software, Quicken software,
and Clip Light.

PREVIOUS RAFFLE WINNERS

Bob Dickson

Carl Rau

Don Armstrong

Gordon Strickland

Jim Sanders

John DeCarlson

Martin LaRocque

Rudy Lauterbach

Steven Breitbart

Vince Lazore
Photos by John Krill

The prizes shown are one of the following:
Canon Pixma iP2702 inkjet photo printer, Logitech wireless keyboard, Patriot memory 16GB USB flash drive,
or a Targus Stylus for phones and tablets.
(Eventually we'll get every member's picture up here, for recognition purposes.)

GENERAL DRAWING PRIZES *: Selected each week by the President.
* Parking stubs are good for two raffle tickets each!
See the article immediately below this list!
MEMBERS-ONLY DRAWING PRIZES
(Wear your NOCCC Badge and get a free ticket!)

Save Your Parking Permits!
To offset the cost of parking in the Lastinger Underground Parking Structure, the NOCCC Board approved a motion to
give each member two NOCCC General Drawing raffle tickets in exchange for the Lastinger-parking permit. Turn the bottom-half
“receipt” part of your permit to the Rafflemeister on the same day or hold it until the next meeting. Gerry Resch, the Raffle
Leader, will exchange it for two raffle tickets.
The reason for this is that the NOCCC Board has found that some people are not attending meetings or not renewing their
memberships because of the parking situation. Chapman University has allowed us to park in the Lastinger Parking Structure
under Wilson Field for only $2 for the whole day of our meeting; normally $2 is good for only two hours. The advantages of
parking there are clear; you don’t have to drive around looking for a legal spot (remember, don’t park on the private home side of
the street), the car doesn’t get hot and you don’t have to parallel park. There is even an elevator available to get down to the
parking area.

Consignment
The NOCCC Consignment Table in the lobby of Irvine Hall will NOT be available during the July 2012 meeting. It is open on even
months, the same as the E-Waste collection.
Consignment Table Rules - coming soon.
E-waste Collection Rules

California disposal laws have made it illegal to put monitors and computers in the regular trash. Omni Technics, Inc. will be
at our regular meetings to collect E-Waste on even months , so save your “junk until April.
Check their web site for more information: http://www.ca-recycle.com /. Or, call (562) 627-1910.
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NOCCC Officers and Club Volunteers
Officers: As of 6/3/2012.
The area code for the following phone numbers is 714 unless noted.
President
Dr. Patricia Adelekan
628-9844
p_adelekan@yahoo.com
Vice President
Dr. Don Armstrong
Secretary
Steven Breitbart
Treasurer
John Heenan
Directors
Dallas Hazleton

773-1187

docarmstrong@gmail.com

486-3070

sbreitbart@socal.rr.com

998-7660

treasurer@noccc.org

526-1592

ghazleton4@dslextreme.com

Ben Lochtenbergh

(949) 653-2545

bal@msn.com

Richard Miller

309-1504

rrrmil@gmail.com

Gerry Resch

772-6667

gerry@gerryresch.com

Gordon E. Strickland, Jr

970-7730

gestrickland@earthlink.net

Tia Christian

583-0404

Iwilliams_00@yahoo.com

Larry Klees

879-7962

larryklees@yahoo.com

Jim Sanders

544-3589

jsanders@ligasmicro.com

Editor
Rudy Lauterbach

529-5730

editor@noccc.org

For any email communication to Officers, Board, or Editor, please include "NOCCC" in subject.

Volunteers, Committees, and Projects
We have numerous interesting assignments available. As an all-volunteer organization, you can join with other members in
a variety of activities: solicit newsletter ads, write articles for our newsletter, conduct a seminar, run a SIG, give a Main
Meeting presentation, show new members around, join a committee, assist in setting up the meeting or participate in computerrelated community volunteer work. Become an NOCCC member by signing up at the Reviews/Membership Desk during a
general meeting, usually the first Sunday of the month.
Consignment Table
Richard Miller

309-1504

rrrmil@gmail.com

772-6667

gerry@gerryresch.com

Raffle Leader
Gerry Resch

Helpline
Membership Database
John Heenan

Open
998-7660

treasurer@noccc.org

(949) 653-254

bal@msn.com

526-1592

ghazleton4@dslextreme.com

Membership Chairman
Ben Lochtenbergh

SIG Coordinator
Dallas Hazleton

Programs/Speakers Coordinator
Dr. Patricia Adelekan

628-9844

Public Relations

p_adelekan@yahoo.com
Open

University Liaison
Dr. Patricia Adelekan

628-9844

Webmaster
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Rudy Lauterbach

529-5730

rblauter@cs.com

Chapman U. Campus Security 997-6763 open locked rooms, problems

NOCCC Help LineVolunteers
The Help Line is in the true spirit of the NOCCC, which is to help others to learn more about computers. The following is a list of
Help Line subjects that a NOCCC volunteer is able to help you deal with. Most volunteers prefer being contacted by e-mail.
Mention NOCCC in the Subject line.
Apple II Gerry Resch 714-772-6667

gerry@gerryresch.com

Corel Draw Larry Klees 714-879-7962

larryklees@yahoo.com

Digital Photography Larry Klees 714-879-7962

larryklees@yahoo.com

Excel Gerry Resch 714-772-6667

gerry@gerryresch.com

GPS Navigation Bob DeWolf 714-879-8269

rsdewolf@adelphia.net

Linux Bob Ray 714-634-7520

bobsdesk@dialup4less.com

Lotus 1-2-3 Gerry Resch 714-772-6667

gerry@gerryresch.com

Microsoft Office John Heenan 714-998-7660

heenanjc@sbcglobal.net

PC Hardware Jim Sanders 714-544-3589

jsanders@ligasmicro.com

Photo editing & Pshop Larry Klees 714-879-7962

larryklees@yahoo.com

QuickBooks - all ver. Linda Russell 909-949-4930

qbqueen@verizon.net

Tcl/Tk & UNIX Bob DeWolf 714-879-8269

rsdewolf@adelphia.net

Windows 7, Vista & XP Jim Sanders 714-544-3589

jsanders@ligasmicro.com

Windows 9X & XP John Heenan 714-998-7660

heenanjc@sbcglobal.net

WiFi & Networking Jim Sanders 714-544-3589

jsanders@ligasmicro.com

Do you want to be an NOCCC Help Volunteer and assist other members with computing subjects
that you know well? If so, please contact one of the directors.

SIG Leaders
Contact the SIG leaders by e-mail, preferably, rather than by telephone.
SIG

Bldg

Rm

Time

Leader

Email

Phone

Linux for Desktop/Admin

Science

13

9:00/10:30

Bob Ray

bobrobo@dialup4less.com

(714) 634-7520

Beginner’s Digital Photog.

Science

127

9:00

John Krill

noccc.bgphotosig@gmail.com

(949) 497-8658

Visual Programming

Science

111

9:00

Anson Chapman

aec@ccliostl.com

(909) 860-9515

Laptops & Social Media

Science

109

9:00

Dr. Patricia Adelekan

p_adelekan@yahoo.com

(714) 628-9844

Word, Excel, & Outlook

Science

306

9:00

Tia Christian

Iwilliams_00@yahoo.com

(714) 263-6105

Mobile Computing

Science

109

10:30

Ben Lochtenbergh

bal@msn.com

(949) 653-2545

Access/Excel VBA

Science

306

10:30

Bob Dickson

robertbdickson@socal.rr.com

(714) 539-1304

Advanced Digital Photography

Science

127

10:30

Larry Klees

larryklees@yahoo.com

(714) 879-7962

Understanding OS’s

Science

111

10:30

Charlie Moore

mooreca@roadrunner.com

(714) 529-9071

Microsoft Access

Science

306

12:00

Bob Dickson

robertbdickson@socal.rr.com

(714) 539-1304

PC Q&A

Irvine Hall

10:30/12:30

Jim Sanders

jsanders@ligasmicro.com

(714) 544-3589

Please report SIG changes to editor@noccc.org . Contact SIG leaders by e-mail, preferably, rather than by telephone.
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Computer Talk
Word Tips

Updates from Ted Littman

Copyright ©2012 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word tips can be
found online at http://word.tips.net.

Changing Outline Structure

            If you find yourself in the position of needing to revise the structure of a document, you can make the job easy by
following these steps:
Make sure you've used the standard headings defined in the Word styles—Heading 1, Heading 2, Heading 3, etc.
Switch to Outline view. (Easiest way is to click the Outline view icon on the status bar.)
Select the head level at which you want to work with the document. For instance, if you must reorganize at the Heading 2 level,
make sure you specify that you want "level 2" displayed in the outline. The way you do this depends on the version of Word
you are using. If you are using Word 97 or Word 2000 , click the 2 tool on the Outline toolbar. If you are using Word 2002
or Word 2003 , use the Outline Level drop-down list on the Outline toolbar to specify Level 2. If you are using Word
2007 , use the Outline Level drop-down list on the Outlining tab of the ribbon.
Position the insertion point somewhere in the heading you want to move.
Click your mouse on the Move Up tool to move the heading (and everything subordinate to that heading) higher in the outline.
The Move Up tool looks like an up arrow.
Click your mouse on the Move Down tool to move the heading (and everything subordinate to that heading) lower in the
outline. The Move Down tool looks like a down arrow.
When you have finished, switch back to your regular viewing mode.
Using the Style Area
            Word can show you what the style names are for all paragraphs in your document. This is useful if you are
editing a document and need to see if the appropriate styles have been applied. To reveal styles on the left side of the
screen, follow these steps:
Make sure you are viewing your document using Normal view.
Choose Options from the Tools menu .
Make sure the View tab is selected. (See Figure 1.)

Figure 1. The View tab of the Options dialog box.
Set the Style Area Width field to a value other than 0. (A good starting point is .5, which represents one-half inch.)
Click on OK to close the dialog box.
At the left side of your document you should now see a style area. Notice that the style assigned to each paragraph is now
visible within the style area. If you want to change the width of the style area at this point, you can do so by using the
mouse. Simply click on the vertical line that sets off the style area and drag it left or right.
You should note that the style area is only visible if you are using Normal or, in some versions of Word, Outline views. If
you switch to any other view, the style area disappears. If you are using any version of Word prior to Word 2000 , and you
cannot see the Style Area Width box in step 4, then you forgot to switch to Normal view, as mentioned in step 1.
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WordTips is your source for cost-effective Microsoft Word training. (Microsoft Word is the most popular word processing
software in the world.) This tip (470) applies to Microsoft Word versions: 97 | 2000 | 2002 | 2003

Excel Tips
Copyright © 2012 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of
free Microsoft Excel tips can be found online at http://excel.tips.net.
Understanding Views

A view is a pattern for what information within a worksheet should look like. This pattern can be given a name and saved
within Excel. The named view can later be recalled quickly. In some ways a view is similar to a scenario. (Scenarios are
discussed in other issues of ExcelTips.) They differ, however, in that a scenario deals with the content (the values) stored in
a worksheet, while a view is concerned with how the worksheet appears.
A view can contain information such as which rows and columns are visible, row height, column width, formatting
characteristics, and window size and position. You can define and store several views of data in a worksheet. For instance,
one view could show the entire worksheet, while another could show a condensed (or summary) view of the information.
Still another could be used to show the full worksheet on the screen at one time.
To create a view, follow these steps:
Format and situate your worksheet as you want it to appear.
Display the View tab of the ribbon.
Click the Custom Views tool in the Workbook Views group. Excel displays the Custom Views dialog box.
Click on the Add button. Excel displays the Add View dialog box. (See Figure 2.)

Figure 2. The Add View dialog box.
In the Name field, supply the name you want associated with this view. This name can be up to 255 characters long,
including spaces.
In the Include in View section, select the options that reflect what you want saved with this view. You can choose to
include both print settings and hidden rows and columns.
When you are satisfied with your settings, click the OK button . The current view is saved by Excel.
You can now proceed to adjust the formatting and display of your worksheet so it reflects what you want saved as the next
view. Repeat this process to store the new view.

Sending Drawing Objects to the Back or Front
When you create objects in Excel using the Drawing toolbar, each object is drawn on its own layer. This means all objects

are independent and can be moved on top of other objects. However, there may be times when you actually want an object
to be under another object. You can do this by following these steps:
Select the pointer tool (the arrow) from the Drawing toolbar.
Using the mouse, point to the shape you want to send to the back, and click on it. Small square boxes called handles
appear around the perimeter of the shape.
Choose Order from the Draw menu on the toolbar. Excel displays a set of ordering commands.
Choose the Send to Back option.
You can do the same sort of arrangement by choosing Bring to Front instead of Send to Back. Excel will move an item
which may be behind others so that it overlays the others.
Hiding Outline Symbols

Once you go through the process of outlining your data, you may want to hide the outline symbols that Excel normally
displays at the left of the worksheet area. These symbols are helpful as you are working with the data, by may be distracting
if you are presenting the data to others. To turn off the symbols, follow these steps:
Choose Options from the Tools menu. Excel displays the Options dialog box.
Make sure the View tab is selected. (See Figure 3.)
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Figure 3. The View tab of the Options dialog box.
Clear the Outline Symbols check box .
Click on OK.
To again display the symbols, follow the same steps, but make sure the Outline Symbols check box is selected.

How to Replace Your Computer's Power Supply
“Your computer's power supply is a critical component, obviously. The power supply converts
alternating current to direct current and feeds power to all the many components of your
computer. But how can you tell if your power supply is powerful enough, or if it's about to die?
How do you decide what kind and capacity of power supply to buy, and how difficult is it to
replace a power supply yourself?”
http://askbobrankin.com/replace_your_power_supply.html?awt_l=DGqD3&awt_m=JP2i0af7.8P6SL
Extend Laptop Battery Life
“It's easy to take electrical outlets for granted; they're everywhere, right? But sometimes you
forget your laptop's power cord at home, or somehow get stuck far from wall power. Then you'll
be glad you followed these tips to maximize the life of your laptop's battery.”
http://askbobrankin.com/extend_laptop_battery_life.html#ixzz1ydwhk3oT
Announcing: The Microsoft Surface Tablet
“On June 18, 2012, Microsoft unveiled its answer to the iPad, as well as the unspoken question,
"What are we supposed to do with Windows 8?" The Microsoft Surface tablet is pretty slick, and
may set a new standard for the tablet industry. Here’s a first look at the new device.”
http://askbobrankin.com/announcing_the_microsoft_surface_tablet.html?
awt_l=DGqD3&awt_m=JazBJbeZE8P6SL
Hey, Is This Your Password?
“According to a study that was just released, there's a 40 percent chance that any hacker could
guess your password without breaking a sweat. Read on to find out if you're using one of the 25
most common (and easily guessed) passwords, and how to create strong, secure passwords that
can't be hacked.”
http://askbobrankin.com/hey_is_this_your_password.html#ixzz1ydzj8ZCA
Free Clip Art and Stock Photos
If you're a student working on a school project, a volunteer creating a brochure, or a webmaster
for a personal or non-profit website, you need clip art images, icons and stock photos to make it
look professional. But your budget is limited, or zero. Fortunately, the Internet is a treasure trove
of free artwork and photography. Some can even be used for commercial uses as well. Here's
where to look for free clipart and stock photos
http://askbobrankin.com/free_clip_art_and_stock_photos.html#ixzz1ye0OMJG4
Skydrive, Google Drive, or Dropbox?

“Online storage and sync services solve a lot of problems for users who work and play on multiple devices. The premise is
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simple: store all your data in one place that can be accessed from wherever you are, using whatever device you have with
you. But which one of the big three cloud storage players is best for you?”
http://askbobrankin.com/skydrive_google_drive_or_dropbox.html#ixzz1ye0wPyuv

Choosing a Smartphone
By Sandy Berger, CompuKISS
www.compukiss.com ; sandy (at) compukiss.com
There are so many different Smartphones available today that choosing between them can be difficult. Each phone and each
operating system has many different pluses and minuses. So today, I'll give you a brief rundown of what you can expect in a
Smartphone.
Windows Mobile cell phones are just coming of age and they may well be a good choice in the future. However, right now
the choice will probably come down to choosing between the Apple iPhone and one of the many Android phones that are
now available.
The Android operating system is upgraded several times a year and new Android phones are released all the time. Apple,
however only releases a new iPhone and a big update to their iOS operating system once a year. The new iPhone and iOS
updates were released in October.
I have installed Apple's new iOS 5 operating system on my iPad, so I have been able to take an in-depth look at most of the
new features. Now I am ready to make my list of the benefits of each.
There is no doubt that that the camera on the new iPhone is superior to almost all the Android phone cameras. The retinoid
screen on the iPhone is superior to most Android phones. The exception is the Samsung line of phones with AMOLED
screens that rival the clarity and crispness of the iPhone screen.
Apple's new iCloud service will automatically backup your iPhone to Apple's servers and let you sync your iPhone, iPad,
and Mac computer. While using iCloud is easier than some of the Android syncing and backup solutions, there were things
that I didn't like about iCloud. For instance, you can't actually see your data in the Cloud as you can with solutions like
Amazon's or Google's online storage.
One of Apple's biggest features is iTunes and the iTunes store. iTunes makes getting music and video on your iPhone easier
than any Android application that I've seen. At this time, both the Android Marketplace and the iTunes App Store have
hundreds of thousands of apps. The iTunes App Store, however, makes it easier to find the apps that you want. Also because
of Apple's stricter app reviews, Apple's apps are more secure. However, the Android Marketplace has a higher percentage of
free apps.
Some of the new features on Apple new iPhone are already available on Android phones. The most prominent of these is the
Notification Center that Apple just added. This is a feature of Android that has been around for a long time and that I love.
Now in either operating system, you can just swipe your finger down from the top of the phone to see all of your alerts,
notifications, incoming messages, and incoming email.
The most unique feature of the new iPhone is Siri, a personal assistant who will answer verbal questions that you ask. This
would, no doubt, be very useful, entertaining, and truly state-of-the-art.
Android phones also have voice capabilities. They use Google's Voice Search. Most screens that popup a keypad for text
entry, also have a small microphone. Just press the microphone and speak. It is amazingly accurate and you can use it for
everything from entering email text to searching to navigating to a point on the map. Probably not as sophisticated as
Apple's Siri, but it works well.
Android phones also have some things that I love that are not available on iPhones. The first of these is the fact that you can
get a larger screen size on an Android. All iPhones currently have a 3.5-inch screen. Several good Android phones have 4.3inch screens. My aging eyes really like the larger screens.
I also like the four buttons on the bottom of the Android screen. These are very, very useful. There is a Back Key, a Menu
Key, a Home Key, and a Search Key. They are always available. They do not change when the screen changes. The iPhone
has just one button. Some will argue that this makes the phone easier to use. Yet, this is not always the case. In some
applications it is impossible to go back a screen. In others there is an on-screen back button but the location of this button
varies with each application. With Android, you can always go back to the previous screen with just one press.
The Android operating system also is more customizable. With Apple, you are restricted to small square apps. With Android
you can use many different resizable widgets as well as the standard apps. All of this gives you many different
customization options, but also adds to the complexity of the phone. With the iPhone you don't get so many choices. This
makes it a bit more restrictive, but also makes it easier to use.
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On other difference is that most Android phones have user-replaceable batteries, while an iPhone battery must be replaced
by Apple at a greater cost. While this might not be important to the average user it may make a difference to a heavy-duty
user.
Well, there are just a few of the pluses and minuses you will have to assess when you buy a new Smartphone. Don't worry
though; it is hard to make a bad decision as almost all the Smartphones on the market today are both capable and useful.

Goodnight Ipad, a Parody for the Next Generation and a Modern Bedtime
Story
Reviewed by Judy Taylour, President, SCV Computer Club, CA
www.scvpcg.org ; scvjudy (at) gmail.com
I imagine many of you read Goodnight Moon by Margaret Wise Brown to your
children as well as your grandchildren….over and over again.
You will want to get a copy of Goodnight iPad to renew the pleasure you had in
reading the original book, but this one is a hoot.
The book begins with a Blue Rider Press License Agreement that covers all of the
copyright information, etc. There’s a notation that says “Don’t bother reading this.
No one does. Just scroll down to the bottom of the page and click.” You have the
choice to click on I have read the License Agreement Terms and Conditions – I
AGREE or I have not read the License Agreement Terms and Conditions – I
AGREE anyway. Don’t most of us just click on the EULA without reading to the bottom and finding we have just agreed to
having our e-mail addresses given to 3rd party partners and everyone else in the whole free world.
This book is for the hopelessly plugged in.
IPads, Doom, eReaders, Angry Birds, a huge LCD Wi-Fi HDTV, Facebook, e-mails, tweets and more are all going on and a
grumpy Grammy is trying to sleep.
You remember how the original book goes: Goodnight room, red balloon, etc. as they go through the nighttime ritual of
going to sleep. Much to her family’s dismay this is what happens in this book until only one member of the family is not
asleep but listening to Grammy read Goodnight Moon.
The book will make you smile and the illustrations are classic. I asked my 14- and 12-year old grandsons (hopelessly
plugged in) if they remembered the original Goodnight Moon – they both did. The book made them smile too but, of course,
they didn’t want things to be unplugged since they can’t imagine life without their Xbox’, headsets and games.
Ann Droyd is the pseudonym for an IRA/Children’s Choices winner who has written and illustrated more than 25 books for
young readers. She has been trying to unplug for at least 15 years. “In Goodnight iPad,” she says, “I sing the praises of
powering down, at least for one night, in hopes I might convince myself to do the same.”
Perhaps we could power down for one night, too.
Goodnight iPad
Ann Droyd < www.anndroyd.com > (you will be redirected)
Blue Rider Press, a member of Penguin Group (USA) Inc., NY
$14.95 US; $17.50 CAN; $10.17 at Amazon

NOOK Q & A
By Mary Phillips, member, ICON (Interactive Computer Owners Network), MO
January 2012 issue, The ICON
www.iconusersgroup.org; mphillip1 (at) sbcglobal.net
Q1.What can and can’t I do with my new Simple Touch Nook eReader? It has Wi-Fi connection.
A1. The Simple Touch Nook is a dedicated eReader. You can read books that are available from a variety of sources and
you can read newspapers and magazines if you have subscriptions.
With the Nook Friends feature you can send emails to share comments and recommendations and lend/borrow some books
from each other.
You can access Barnes and Noble‘s bookstore via the Wi-Fi. Word meanings can be looked up and passages can be
highlighted and bookmarks can be made.
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You cannot play games or music as can be done with the Color Nook or the Nook Tablet.
Q2. Where can I get Help with my Nook features?
A2. On your computer, go to bn.com and click on the tab. Under Nook Simple Touch (or other Nook device if you have a
different one), select Support. There are four video tutorials, a section of Frequently Asked Questions, a Chat with a Nook
Expert Chat Now
button, and the User Guides and Manuals that are also on your Nook when you get it,
but it is much easier to search for information and read IT on the computer.
Barnes and Noble help can also be reached by phone M-F 7 a.m.-10 p.m. and weekends 8 a.m. to 10 p.m. by calling 800843-2665. I‘ve had two chat sessions and both “Experts” were very helpful. Also, the Barnes and Noble book store folks
have
been very knowledgeable and helpful.
Q3. How do I get books loaded onto my Nook from Barnes & Noble?

A3. Books can be purchased from B&N by pressing the Quick Nav button at the bottom of the Nook and tapping Shop on
the Quick Nav Menu Bar that appears across the bottom of the screen.

If you want to look for free ($0.00) books, tap the Search Shop button in the upper right corner. The next screen has a
keyboard and search bar into which you type either the title or author of the book or the price and then tap the Search button
in the lower right corner of the keyboard.
Scroll through the titles by either sweeping a finger up or down on the screen or tapping the up and down arrow points at the
bottom of the page.
If you know a title you‘re looking for or to see an overview, tap on the cover picture. If it‘s a free book, tap on the Free
button, then Confirm and the book is immediately downloaded directly to the Nook. If the book has a more significant price,
click on the Buy button and follow the instructions; it will be downloaded to the Nook. This has to be
done where you have a Wi-Fi connection.
Q4. I’ve heard that on Fridays, Barnes & Noble offers a free eBook to be downloaded. How do I find it?
Go to bn.com and type in the Search bar ― “Free Fridays” (without the quote marks). This will take you to B&N
Community, the NOOK Blog and the free book will be listed there.
You can also type or copy the address below in the browser address bar:
http://bookclubs.barnesandnoble.com/t5/TheNOOK-Blog/bg-p/Unbound.
To get the Free Friday book, it‘s necessary to download the book to the computer and then transfer it to the Nook. Do the
following:
Click on the title of the book. The link is in blue text and when the mouse pointer is hovered over it, the pointer
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changes to a hand with a pointing finger.
The link takes you to an overview of the book and a Download Now button. If you think you want to read the book,
click on the Download Now button.
Navigate to the folder where you want the eBook to be saved and click Save.
Attach the Nook by the USB cable to the computer. Windows will recognize the Nook as a Removable drive and
assign it a letter.
The next step is to Copy the file and Paste it into the Nook folder named Books.
            a. Right click on the filename and select Copy    
b. Click on Computer, double click Nook, double click My Files, double click
    Books, right click and select Paste.
6.      Disconnect/eject the Nook as you would a flash drive by clicking on the Safely Remove Hardware and Eject Media
icon in the notification area of the computer screen and then selecting Nook from the menu. Wait until you see the
message that says it‘s okay to remove the device.
Q5. How do I move from page to page in a book?
A5. There are three ways to move from page to page:
There are two “buttons” or bars on each side of the Nook. The top ones (either side) move to the next page and the
lower ones move to the previous page when you press on them.
You can Fast Page through the book by pressing and holding down these buttons. The buttons are not very easy to
press. Swipe across the screen with one finger in either direction to advance or go back a page.
Gently tap on the right edge of the screen to advance or tap on the left edge to go back.
Q6. How can I look up a word for which I want the definition?
A6. Gently press your finger tip on the word and it will become highlighted with a vertical rod at each end. A text selection
Toolbar appears at the screen bottom. Tap Look Up.

Q7. If I’m doing research and I want to highlight text or make a note about it, how do I do it?
A7. Press a word at the end or the beginning until it‘s highlighted, then drag the appropriate rod to the other end of the
desired text. Tapping Add Note brings up the keyboard. Tapping Highlight appears to put underlines under the highlighted
text. Tapping the highlighted text will also allow you to remove the highlight or add a note.
To see material that‘s been highlighted or notes made about, tap on text that‘s not highlighted; that brings up a Reading
Tools Menu. Tap Content.

Q8. How do I make a bookmark?
A8. To place a bookmark on a page, tap in the upper right corner of the page and a dark bookmark will appear. To see the
pages bookmarked, tap to open the Reading Tools Menu and tap Content.
Q9. How do I Find specific words in a book?
A10. Tap in the middle of the text, tap Find on the Reading Tools Menu, type the word you are looking for in the search
box, and tap the Search button on the bottom row of the keyboard. Tap Close when finished.
Q10. How do I change the size of text and margins?
A10. On the Reading Tools Menu, tap on the text button. This opens a Text Dialog Box.
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Tap on the A of the desired text size to make the change; tap on the desired line spacing, and the desired margin. There are
also six font styles from which to choose. Just tap!
Q11. What is a Nook Friend, and how do I Invite someone to be my Nook Friend?
A11. A Nook Friend is a friend who has a B&N account, an email address in your contacts list, and has accepted your
invitation to connect as a Nook Friend. Nook Friends can lend each other books and request books from each other for a
loan of 14 days. A book can be loaned only once. This requires a Wi-Fi connection:
Press the Quick Nav bar, tap Settings, tap Social and set up each of the items below.

To enable Sharing features, you must be linked to B&N via either Google Gmail, Facebook, or Twitter. Tap on this
feature and follow the prompts to sign in. Tap the Grant Access button.
Tap on Manage my Contacts. Tap on the drop down arrow beside All Contacts and select Nook Friends. Tap Add
Contact.
Tap in each box and fill in First Name, Last Name, and email address (doesn‘t have to be a Gmail address), then tap
Invite as Nook Friend. Tap Save at the bottom of the keyboard. Tap Close.
If the friend‘s email is already in your contact list, just tap on the name and tap Invite. Tap Send. Tap Close.
3.      When your friend accepts the invitation, the name will be listed under Manage my Nook Friends. Tapping the name
will show the books they can lend to you. Tap Details for info.
4.      Visibility of LendMe books is controlled by tapping the Show/Hide button.
Q12. What formats are compatible with the Nook?
A12. The Nook supports ePub and PDF formats for books and .jpg, .gif, and .png for screensavers.
You don‘t have to have a Nook to download books from B&N, you can download an app for your PC, laptop, or
smartphone.

Tips for Mixing Graphics with Text
By Nancy DeMarte, Regular Columnist (Office
Talk), Sarasota PCUG, Florida
January 2012 issue, Sarasota PC Monitor
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http://www.spcug.org/; ndemarte (at) Verizon.net
Have you had this frustrating experience when
working with Microsoft Office? You are writing
your holiday newsletter in Word and have some
good photos of the cousins and grandparents to
include. You’ve typed the text and have chosen
an appropriate spot for the first photo to
appear. You click in this spot, and then click
Insert - Picture. You locate the photo in My
Pictures, select it, and click Insert. The photo
appears, but not where you want it. When you
try to drag it to its chosen place, it either won’t
move or pushes too much text below it, leaving
a blank space between the photo and the
margin. Welcome to the tricky world of mixing
graphics with text.
A
graphic
(photo,
shape,
WordArt,
or
drawing
object)
inserted
into text
is either
Inline or
Floating. The default property is Inline, which means that a photo will keep its position relative
to the text. In the example above, you want the photo to stay related to specific text, so Inline
seems like a good choice. But you also want the ability to move the photo around, if needed, and
to eliminate the extra white space next to the photo. You need to make the photo floating, which
means the photo will keep its position relative to the page, rather than the text. To do this, you
need to adjust what is known as Text Wrapping. Once your photo has been inserted, right click
the photo to get a menu of options. In Office 2003 and earlier, choose Format, then Text
Wrapping. In Office 2007 and later, choose Wrap Text. Then select either Tight or Square. Both of
these allow text to wrap neatly around the photo, with Square allowing a bit more space between
the text and the photo. Once you have wrapped the text, you can also easily drag the photo to
different places on the page.
But let’s suppose you wanted to place the photo in the exact center of the page. In Word
2007/10, select the photo, which opens the Picture Tools tab. Click the Format sub-tab and, in
the Arrange group, click Position. Click the icon with the graphic centered and watch the photo
jump to the center. You can position a graphic even more precisely by clicking “More Layout
Options,” choosing Size, and typing an exact location measurement.
Once a photo has been inserted into a document, you may want to take advantage of the simple,
but useful enhancing and editing tools for photos which are features of the Office 2007/10 suites.
When you select the photo, the Picture Tools tab appears in the ribbon. Click Format. Here you
will find a variety of photo-enhancing tools, the most dramatic being the Styles Gallery, which
contains borders and 3-D effects. Browse the gallery by selecting the photo and hovering your
mouse over the styles one at a time. You can also make simple edits to brightness, contrast,
color saturation, and tone using the editing tools on this tab. There is also a basic cropping tool.
If you decide you prefer a different photo altogether, a click of the Change Picture button allows
you to replace the current photo with another from your computer.
Another pair of useful terms to know is Order and Grouping. These are especially useful when
working with shapes. You might, for instance, want to combine several shapes in a document to
create a logo or other design. First click Insert – Shapes and insert each shape individually. Then
drag them into an overlapping arrangement, as shown in the illustration. To change the order in
which they are layered, right click one of the shapes, click Order, and select your instruction,
such as “Bring to front.” When the arrangement is complete, you can preserve it by grouping the
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elements. First select all the shapes by clicking Select – Objects in the Editing group on the
Home tab. Then drag a dotted box around the group of shapes to select them all. You can tell you
have them all selected when “handles” are visible around each object. Right click the group, and
then click Grouping – Group. The separate shapes have now become one and can be moved
without changing their arrangement.
It is also helpful to know the difference between a graphic which is embedded and one that is
linked to file. Graphics are embedded by default, meaning a copy of the inserted graphic is
located in the document file. This is usually appropriate. The ‘Link to File’ option, however, offers
some advantages in certain situations. Let’s say you have a large document with many photos
and want to reduce its file size. You can insert a photo so that it is linked to its real location on
your computer, such as My Pictures. Click the Insert tab – Picture. Locate and select the photo.
Instead of clicking the Insert button, click the arrow next to Insert and choose Link to File. A
virtual image of the photo appears in the document with a much smaller file size than the
original. If you edit the photo in its actual location, the changes are reflected in its virtual image
in the document.
Another valuable use of Link to File relates to charts. Let’s say you have created a pie chart in
Excel and want to insert it into a document. Because the data is this chart will change
periodically, you can link the chart to its data set in Excel so it updates as you modify the data.
This is much easier than recreating the chart each time the data changes. To do this, create the
chart in Excel and paste it into the document using the “link data” paste option.
A caution with “Link to File” is if you change the location of the source file, the connection is
broken. A photo will not be visible, and no longer will the chart change along with the source file.
You can avoid this problem by choosing ‘Insert and Link,’ which both links the graphic to its
source and also inserts it. The graphics will always be visible in the document, even if the link is
broken.
Graphics add a lot to documents. Experiment with them using these tips.

Product Reviews
HTML5 Canvas

Updates from Ted Littman

Native Interactivity and Animation for the Web
Book Review by Iris Yoffa, Member, Tucson Computer Society, Arizona
January 2012 issue, eJournal; www.aztcs.org; Irisonthego (at) gmail.com
Not sure what it is or if you need it? With the recent announcement by Adobe
that support for the development of the flash player plug-in for mobile devices
will not be continued, there is cause for developers of Flash-based mobile apps
to look at other technologies.
Adobe’s additional comment stating that HTML5 and JavaScript would be the
technologies to focus on, as they are “universally supported,” sounds like good
advice. If you are immersed in animation for the web and mobile devices,
HTML5 Canvas could be your door into this new world. The authors are both
Game Engineers and have a strong background in Flash, Silverlight and
HTML5 Canvas.
This book is divided into 11 chapters and is all about learning the HTML5
Canvas API (Application Programming Interface).
The first four chapters use the method of “tutorial by example” or learning by
coding, as the means of instruction and include a rather swift intro to the
elements in the new HTML5 specification. The chapter titles give a good idea
of the subject matter covered and are as follows:
1. Introduction to HTML5 Canvas
2. Drawing on the Canvas
3. The HTML5 Canvas Text API
4. Images on the Canvas
5. Math, Physics, and Animation
6. Mixing HTML5 Video and Canvas
7. Working with Audio
8. Canvas Game Essentials
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9. Combining Bitmaps and Sound
10. Mobilizing Games with PhoneGap
11. Further Explorations
The book begins Chapter 1, Page 1 by promising to “break down the Canvas API into digestible parts and then put it back
together, demonstrating how to use it to create applications.” Just what I was looking for!
In combination with JavaScript programming there is the possibility of creating animations, applications and games. When
an external resource is called for (no pun intended), the URL for download is provided. The code to insert onto your HTML
page is given, as is an explanation of what you’re doing and why. The text is clear and the step-by-step training is easy to
follow. Since I have forgotten more JavaScript than I ever knew, this was most welcome.
Chapter 1 also includes an introduction to simple JavaScript debugging using Console.log. Most modern browsers provide
support for this function. For Internet Explorer fans, this would be a good time to install an alternate browser such as
Chrome, Opera, Safari, or Firefox with the Firebug plug-in.
The first chapter even includes the code and step-by-steps for creating the game “Guess the Letter.” This provides a basic
walk-through of the HTML5 and JavaScript used to “render and control HTML5 Canvas on an HTML page.” I am still
working very slowly through the first part of this book and will continue as the information and concepts become integrated
into my bag of skills.
So, it looks as though the future of interactivity and animation on mobile devices rests with HTML5 Canvas for the present.
This book of the same name is a comprehensive training guide for anyone looking to become proficient in this technology.
Although this volume was written and printed before the profound announcements by Adobe, the authors would seem to
have remarkable insight into the future of web technology. The dedication page contains simply the words “To Flash.”
About: HTML5 Canvas
Authors: Steve Fulton and Jeff Fulton
Publisher: O’Reilly Media
http://shop.oreilly.com/product/0636920013327.do
ISBN ‑ 10: 144939390X; ISBN ‑ 13: 978-1449393908
Price: $39.99, Amazon $26.39

Paintshop™ Pro X4
Software Review by Clint Tinsley, Editor, Idaho PCUG; October 2011 issue, Bits and Pieces
http://idahopcug.apcug.org/; c_tinsley (at) msn.com
Extensively reworked with new defined workspaces and a number of new features, Corel
released Paintshop™ Pro X4 in September 2011. With new features and enhancements totaling
over 75, it is awesome. Both the standard and Ultimate additions are available for purchase from
the Corel Website. There is also a free 30 day trial available for downloading. At
http://www.corel.com/paintshop, you can find more information about Paintshop™ Pro
X4 along with a link for downloading the 30 day trial. There are also a several new videos on
You Tube showing off the new features and enhancements that could be the subject of a book;
http://www.youtube.com/watch?v=R1Qzx5G-Nhc or just search YouTube for “Corel
Paint Shop Pro x4” where you will find a wide selection of videos.
X4 New Workspaces
The graphic shows the
new workspaces in X4
which are Manage
(Photo Manager), Adjust
(replaces what was the
Express Lab in X3) and
the Edit workspace,
formally “Full Edit” in
X3. The changes go
beyond just the name
changes as the tools have
been improved and
access is friendlier. In
this first graphic, you see
one of the new tools, Fill
Light/Clarity, available
as an adjustment. This
new tool allows you
apply fill light to dark
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areas of the photo,
drawing out the detail,
along with a clarity
adjustment to sharpen up those areas. The Adjust panel is new and occupies only the left side of the workspace. This is
important with the new 1368X766 laptop screens in that it doesn’t use the top and bottom space, giving you more room to
see and work on your photo as well as room for the Organizer.
Also, in this view, you are provided the camera’s exif information from the photo just below the histogram. Next up is a
small tool bar providing access to the Crop, Straighten, Red Eye, Makeover Tools (Blemish Remover, Toothbrush Teeth
Whitener, Eye Drop for the Eyes, Suntan (no tanning salon here!), and Thinify ( no exercise or dieting required), and finally
the Clone Brush. Clicking on any of these tools or the tools in the list will result in a window opening such as you see for
the Smart Photo Fix. Other tools in Adjust are Color Balance, Brightness/Contrast, Local Tone Mapping, High Pass Sharpen
and Digital Noise Removal. Then under the photo space are some additional tools for rotating the photo and sharing. The
bottom is the Organizer with tools for quickly opening photos for adjusting.
Many of the tools that were available in X3 have been greatly enhanced. An example of this is
the HDR tool which is being touted as a new in X4, was available in X3, but in X4, there is a
complete new tool set for HDR. With X4, there are many adjustments you can make to the
composition and creating a true photographic work of art. HDR is short for High Definition
Resolution and takes advantage of new digital cameras that allow you to “auto bracket” a shot
where the camera takes a sequence of photos of the same shot but with different exposure values
(ev units) such as -3, 0, and +3 with the result that you get a picture that is underexposed (-3),
one normal, and one +3, slightly overexposed where the sky and bright area will be blown out
but you will have more detail in dark areas. The –3 under exposure preserves detail in the bright
areas so that when you combine the three photos using HDR, you get a well detail (high
resolution) photo with good detail in all areas of the photo from dark to light. Again, this HDR
Adjustment panel only occupies the left side of the workspace. One other point to be made here is
that X4 is also 2 monitor friendly so that you can move the editing workspaces to a second
monitor for more room on your desktop.
More New Tools
Photo Blend! This new tool provides you the ability “blend” two photos together (assuming
similar content), taking the best from the two to make one composite photo. An example of this
is family photos, particularly those with children in them or other members that may not be well
behaved. Using Photo Blend, you can selectively “brush out” and “brush in” the desirable
elements to make a great photo. Best use of this tool does require that the photos be very close in
composition such a being taken using a tripod or at least a very stable hand on the camera.
New also is the Selective Focus tool. Using this tool, you can blur the photo while keeping focus
on an area of the photo that you want to draw out; this is different than “depth of field” where
you bring focus to only the foreground or a specific object of focus. Using this tool, you can
define the area to remain in focus along with blur amount, edge softness (hardness), and color
saturation.
Vignette is another new tool. Using this tool, you can “vignette” an area that remains in focus
while the surrounding area is made to blur and fade to black (or degree of darkness) with
adjustments for amount of blur, amount of glow, and again, the feather of the edge in defining the
hardness of the edge.
Many areas have been improved or enhanced in X4. One of those areas is the Camera RAW lab for working with your
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Camera RAW photo images. 16 bit color support has been expanded to over 20 tools resulting in better detailed corrections
using tools such as the Scratch Remover, Object Remover, some brushes, and the Background Eraser.
Paintshop™ Pro X4 is leaner and meaner now; even the install file is smaller. X4 has over 75 performance improvements
including GPU optimizations which are noticeable with many operations now done in real time. Perceivable improvements
in operations like noise reduction and Camera RAW file decode operations.
Learning Paintshop™ Pro X4
Starting with the Getting Started Welcome or splash screen, help in learning X4 is always close by.
On the Welcome screen, are links to information on using the new Manage, Adjust and Edit
workspaces plus links to The Digital Workflow and Learning Tools. In the Edit workspace, you
will find the Learning Center shown here. The choices there will take you to the tools for the
activity and guidance on using them. The F1 Help key is well thought out in that if it senses there
is an Internet connection, you get the latest help information from the Corel website and if you are
not connected, it opens same help information from a local copy that was current at installation
time. Another source of help is the Help on the Menu bar where you will find other help resources.
There is also a 194 X4 User Guide PDF available. And there are the numerous videos posted on
You Tube that I mentioned at the start of the article which you can find with a simple “Corel
Paintshop Pro” search on You Tube at http://www.youtube.com.
What’s in the Box?
Corel has a number of offerings and upgrade paths available to both new and registered users to
get to X4. I initially did the standard upgrade download from an Email that I received as a
registered user. My download including the X4 software, User Manual PDF eBook, the KPT plugin filters “extras” and a copy of WinZip 15. All for $49.99 ($10 off regular price). For $20 more,
there is the Ultimate edition where you also get Nik® Color Efex Pro™ 3.0 photo effects and filters, a $200 value, royaltyfree images from Fotolia, also a $200 value, a Custom photo book from Blurb®* ($35 value), and a collection of Free
Picture Tubes™ . I haven’t seen retail or street prices yet for Paintshop™ ProX4 but expect them to be in the $60 and $80
ranges for Standard and Ultimate respectively. And if history is any indicator, Corel may change it product offerings as to
what is in the box. In the past, I have seen them include a 2 GB USB drive and a free eBook.
System Requirements
Microsoft® Windows® 7, Windows Vista® or Windows® XP, with latest service packs installed (32-bit or 64-bit
editions).
1.5 GHz processor (2 GHz or faster recommended).
1 GB RAM (2 GB RAM or higher recommended).
1 GB free hard drive space (2 GB or greater recommended).
1024 x 768 resolution, 16-bit color display.
Windows-compatible CD-ROM drive for installation.
Internet connection required to post photos online and download program updates.
Concluding Notes
I am quite impressed with Paintshop™ Pro X4 as issues I had with X3 have been resolved including cropping operations
and printing. I can do just about everything I want to do with a photo inside X4. PSP has the all the tools that it has had over
the years including extensive layer support where you can preserve the original photo as the background layer and overlay it
with multiple layers in adjusting the various objects within the photo as well as adding new objects such as content from
other photos, picture tubes, picture frames, and text on top of the original photo. You can also adjust the visibility or
transparency of those layers.
Another feature I like is the Crop to New Image where when I can scan in multiple pictures at the same time and use this
feature to automatically create a new file from the cropped area and keep the original full scan open, so individual photo
files can be easily separated from the scanned image.
One feature I am not crazy about is Smart Carver™ which is supposed to seamlessly remove foreground objects from your
photo. It is not seamless in its operation, it does leave a perceivable line in the picture, as it works by essentially creating a
“fold” in the picture where the object was which can reduce the width or height of the picture if you don’t compensate. Also,
you have to mark the areas you don’t want “distorted” by the operation. The “Art” in removing an object is to replace the
background behind the object being removed so that it truly “seamless.” This can be easily achieved if you have two similar
photos, one with the object and one with the background so that you can clone the background. Other approaches similar to
Smart Carver™ found in other programs also fall short. I have found one tool that can “synthesize” the background and
when used with the clone tool comes very close, the GIMP editor and it is free.
Other Paintshop™ Pro tools that I like which are very effective and easy to use include the Smart Photo Fix, Straighten tool,
Perspective tool, fishbowl correction, Clone, Makeover tools and the color changer.
I highly recommend upgrading to X4 even if you have X3 because of the redesigned work spaces are better organized and
laptop friendly in use of the desktop plus all those new features and enhancements to existing features.
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Products Available for Review
The NOCCC regularly receives copies of books and sometimes software from vendors for our review. We can also
request specific products for you to review. These reviews are published in this newsletter, the Orange Bytes. Then, you
get to keep the book or software. If you are interested in doing a review, please send an e-mail to reviews@noccc.org
and provide your membership number, phone number, and e-mail address. You can pick up the product in the lobby of
Irvine Hall between 9 A.M. and Noon at the regular monthly NOCCC meeting
Note to Reviewers
• You have 2 months to submit a review. Due-cause time extensions must be requested from the Reviews Editor.
• You must leave a security deposit (check, credit card number, or cash equal to the product’s list value.), returnable upon
our receiving an acceptable review.
• If you decide to return the product without reviewing, there is a $2 penalty after the first month and a $5 penalty after
the second month.
• Guidelines for preparing your review are addressed on the next page.
Books
Social Networking & Internet
New: On Top of the Cloud: How CEO’s Leverage New Technologies to Drive Change & Build Value Across the
Enterprise – Authored by Hunter Muller from John Wiley & Sons. MSRP=$65.
New: The Internet for Dummies – Authored by Levine & Young from Wiley. MSRP=$25.
Twitter for Dummies – How to connect with others in 140 characters. Book by Fitton, Gruen, & Poston from Wiley.
MSRP=$22.
New: Twitter Marketing for Dummies – Use Twitter to build your network, spread your message, & communicate with
your customers. By Kyle Lacy from Wiley. MSRP=$25.
New: LinkedIn for Dummies – How to join & use the largest online network for professionals. By Joel Elad from Wiley.
MSRP=$25.
New: Mom Blogging for Dummies – Learn how to set up your blog and use it to sell your products & services. From
Wendy Piersall from Wiley. MSRP=$25.
New: The Back Channel – How audiences are using social media & changing presentations forever authored by Cliff
Atkins. From New Riders. MSRP=$35.
The Digital Afterlife – How to secure your digital assets for your heirs. By Evan Carroll & John Romano from New
Riders. MSRP=$25.
Mining the Social Web – Analyzing data from social media sites by Matthew Russell. From O’Reilly. MSRP=$40.
Digital Photography & Design
New: The Photoshop Elements 10 Book for Digital Photographers – Authored by Scott Kelby & Matt Kloskowiski from
New Riders. MSRP=$50.
New: Adobe Photoshop Elements 10 Classroom in a Book – The official training workbook from Adobe Systems. From
Adobe Press/Peachpit Press. MSRP=$45.
New: The Portrait Photography Course – Principles, practices, & techniques. By Mark Jenkison, from Peachpit Press.
MSRP=$40.
New: Professional Portrait Retouching Techniques for Photographers using Photoshop – Learn how the pros do it. By
Scott Kelby, from New Riders. MSRP=$50.
Canon PowerShot G12 – From snapshots to great shots by Jeff Carlson from Peachpit Press. MSRP=$25.
The Photoshop Elements 9 Book for Digital Photographers – New Riders book by Scott Kelby & Matt
Kloskowski.MSRP=$50.
New: Adobe InDesign CS5 Classroon in a Book – The official training workbook from Adobe Systems. Includes a CD.
From AdobePress. MSRP=$55.
Real World InDesign CS4 – This book covers the waterfront on Adobe’s new design suite. Authored by Olav Kvorn &
David Blatner, it is published by Peachpit Press. MSRP=$55.
Your book reports will be published here.
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SIG Meeting Reports
With previews of the July meeting.

Visual Basic for Applications
(Access/Excel VBA)
By Bob Dickson, SIG Leader

Preview: In July, we’ll start at the ‘front of the book’ and take a look at how one opens the Visual
Basic editor to be able to generate program code for those special, unique, and creative routines.
OK, so we won’t be programmers by the end of this session but we, hopefully, will be able to open
and work with Macros and the Visual Basic Editor. The intent of this session will be to make the
operator more familiar with ‘getting VBA out of the box’ and ‘looking under the hood’. Just
opening the program will present to the operator a wonderful array of features and capabilities for
many routine-type operations. In this session, we’ll look at both Access and Excel and review /
demo locating and activating the Macro and VB Editor sections. These are two different systems
and writing code in one does not necessarily translate into being able to write code in the other, but
a basic understanding of how to activate the Visual Basic Editor in each language enables one to go deeper into creating
those ‘special’ functions that will make your Access or Excel program really productive for your special needs. Of course, if
you already have some capability using VBA in one or both of these systems, we’ll be happy to have you raise a question or
present a wonderful routine you would like to share with others. We love to share in others’ creative endeavors and are
always willing to be shown a better way to do ‘it’! Come up to Sci 306 at 10:30 am to noon.
Post meeting report: The July SIG session on Access / Excel VBA was mainly devoted to understanding the use of Drop
Down Lists and Combo Lists. I have two big programming texts that explain everything about VBA in Excel. The problem
is you need to know the subject before reading the text. Really. I read the material in both texts and tried several times to get
the Combo Box to function. I just wasn’t getting something in all those words, or the examples in the text. So Tia and I sat
and worked several versions of code. Nope. Excel just wasn’t cooperating. Then Tia asked, “What about .....?” Bingo! That
was it. We got the List Box to work. Then I went back to the book and read it again. OK, now that we had functioning code,
the text was understandable. I’ve got two projects I’m working on. Incorporating the Combo Box would make them easier to
use when entering data: just click your selection from the list. And with the Combo Box option, if what you need isn’t
displayed in the list, enter a new code in the box at the top. I’ve used list boxes and combo boxes in Access and VB itself
but not in Excel VBA, so getting around the ‘hump’ took some time and effort. But that’s what these SIG sessions are for.
And some of this was new to Tia, too. She’s been using these products for some time but, as with me and most people, you
tend to reach a comfort level that meets your work requirements and that kind of ends the need or urge to try other parts of
the language. Without a specific work need and schedule, we can go exploring into parts of the language that we rarely, or
never, use.
Another feature of Excel VBA is hiding / revealing worksheets. I have a program that has lots of control data maintained on
a certain worksheet. The concern was that the operator would ‘shortcut’ the program and go directly to the worksheet and
alter it rather than using the User Form. By hiding the worksheet, the operator can’t work it or read it. Under program
control, the worksheet can be read and/or written to while it’s hidden from the active worksheet. That’s a neat feature that
Richard introduced me to a few months ago.
Our approach in this SIG session is to work on actual projects since that provides more incentive to get into the problem and
find out what code with get the job done. Sometimes we have to dig into the language to find the solution but digging deep
is a wonderful educational process and very instructive. If you have some project that might fit itself on a computer, come up
to Sci 306 at 10:30 am and we’ll be more that happy to ‘chew’ on it with you. We use mainly Excel 2003 because that’s
most widely used but we also have Excel 2007 and work in that, too.
This SIG meets in Science 306 at 10:30

MS Access
By Bob Dickson, SIG Leader

Preview for July: An often overlooked part of Access is the many wonderful templates
prepackaged with the product. There is a wonderful array of templates that cover many common
uses on this database system. Both on your computer and available online are templates for almost
every need. We’ll review these templates to get better acquainted with the capabilities they provide.
Why struggle to build a database from scratch when there may already be available a template
database that will lay the groundwork and maybe cover 60-80 percent, or more, of your needs? An
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old saying is: let the Wizard do the work, then modify it to better fit your requirements. If there’s a
template that somewhat fills your requirements, click a button to create it, then open it up and make
some modifications that will exactly fill the bill. Come up to Sci 306 at Noon to 1:30 pm. If you
have some questions about Access other than the templates, we’d love talk about them and hopefully provide an answer. If
you have used a template and are willing to share your experience with us, wonderful. We’ll see you in Sci 306. Fill your
coffee cup, maybe buy a cookie, and come on up.
Post meeting report for July: Access out of the box [of course after the download] has a wonderful number of templates.
There’s a template for almost every need. Select a template, click on it and sit back. The program will generate a database
for you. Then you can open the tables in DESIGN mode and make any desired changes. This is a really neat method to
getting a database built quickly, and especially if you are not familiar with creating a database from scratch. We looked
through the templates and built one. It was quick and very professional. Within a few minutes we were ready to start
entering data. It’s not likely the standard database is exactly what one needs, but it mostly is, so the next step is to open the
database in DESIGN mode and make changes to the fields in the tables, designs, forms and reports. Letting the computer get
the database built and then modifying it is a great way to quickly get your project into production.
We cut the meeting short since the big celebration meeting was starting earlier than usual. But we had some time to help
explain some features in Excel (hey, this is friends helping friends and there was someone who had some questions about
Excel so we spent about 30 minutes on that topic). We explored using the column and row header lines to be able to alter the
standard features of the rows, columns, and cells. We also touched on controlling the display of the worksheet. All in all, it
was a productive and educational meeting.
Come up to Sci 306 at noon and we can discuss if Access can be of help in solving some problem. It was to Helen in
building databases for her quilts and dolls collections. Do you have a collection of some kind that can be made more useful
by being put into a database? Come up and let’s discuss it. If you have used Access for some project and would be willing
to share your experience, we’d love to let you enlighten us of your endeavors.
This SIG meets in Science 306 at Noon

Mobile Computing
By Ben Lochtenbergh, SIG Leader

Report for the June, 2012, meeting.
Tom Feeley downloaded the Microsoft PowerPoint viewer on two of his PCs
and was viewing this month’s presentation on his laptop even before I could
setup my laptop PC in the classroom. I included the download information
and link in the monthly email to the 23 on the list. My wife could view it on
her Blackberry. Her download took 10 minutes instead of 20 minutes because
there was only one attachment this time.
Two people, Muriel Fitzsimmons and Bill Thomas, brought in their newly bought devices and the data
about them was shared and entered into the SIGs database. We now have 31 devices in that Access database but only 17 are
actively brought to SIG meetings. I will have to do some Access programming to filter out the none-active devices and then
email the active device owners the data we currently have. The idea is to share and better understand the information we
have collectively.
Perhaps funny, I learned a new lesson: I’d bought a set of dry erase markers to write on the whiteboard in front of the
classroom. Since it came in 12 colors I picked the color Orange. Well, I learned the writing was not readable beyond the
first row. I hereby apologize for that and promise to use a black marker next time.
In the early part of the meeting we went into some of the basics like view what Android version the new Bionic 4G device
has and look for system update availability. Also, we touched on how to search for and download an app. Richard Miller
asked a pertinent question about how to view the SIG presentation on a DROID smartphone. I deferred the question
because we are still struggling with every one viewing the SIG presentations on their PC. I had not done that viewing for
about a year, we only have 90 minutes, and I wasn’t certain of the outcome.
A few days later I emailed him my answer, not at least because he also initiated the question via email.
I again showed DROID 2 running the free Microsoft Windows 7 Phone app for Android named Launcher7. Bill Thomas
commented there is also an app named Laucher7-Pro which costs money. I’m considering buying it because I like the tile
interface. If I were to put in words why: “I like it’s the simplicity”. The screen shows only 8 tiles at a time. My most
favorite ones are therefore close to the top, scrolling down is an option to see more tiles. One can easily rearrange his tiles.
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I have 11 favorite titles which surely will increase. When I need to see all my apps I slide the screen to the left (they appear
from on right). An alphabetic list appears and sliding the screen up (they appear from the bottom) will eventually show them
all. It has a search that accepts typed text and partial words, but not voice. Then if one sees the one he wants, just touch the
line and the app starts as usual. That is as if you don’t have Launcher7. At the bottom there is a line with an ad which
doesn’t slide away but is present all the time. It is smaller in height then the 9 tiles you see at a time, thus not too intrusive.
But for a few bucks you can eliminate that, I assume. You can change the color of all tiles at once when going into
Launcher7 settings. I counted 14 settings.
If this is a fair representation of the Microsoft smartphone operating system user interface then the rest may be good too. It
may make it big in the market place eventually. I see some glimpses of genius behind the design like what I saw when
Windows, Excel, and Internet Explorer came out. Don’t count Microsoft out.
This SIG meets in Science 109 at 10:30 a.m.

Linux Desktop & Administrator
By Bob Ray, SIG Leader

TBD
These SIGs meet in Science 131 at 9:00 a.m .and 10:30 a.m.

Beginner’s Digital Photography
By John Krill, SIG Leader

This SIG meets in Science 131A at 9:00 a.m.

Advanced Digital Photography
By Larry Klees, SIG Leader
This SIG meets in Science 131A at 10:30 a.m.

PC Q&A
By Jim Sanders, SIG Leader
Jim’s two SIGs meet in the Irvine Hall at 10:30 a.m. and 12:30 p.m., respectively. The first
is the Beginner’s PC Q & A and the second is for everything and everyone else.
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Understanding Operating Systems
Charlie Moore, SIG Leader
A continuing discussion group about Operating Systems for computers.
This SIG meets in Science 111 at 10:30 a.m.

Visual Programming
Anson Chapman, SIG Leader
A continuing discussion group about computer programming using Visual Basic, Visual Basic Script, Visual C,
Visual C++ and Visual J++ for Beginners.
This SIG meets in Science 111 at 9:00 a.m.

Laptops, Smartphones, and Social Media
By Dr. Pat Adelekan, SIG Leader
This SIG meets in Science 109 at 9:00 a.m.

Microsoft Office
Tia Christian, SIG Leader
Open forums for problems incurred using Microsoft Word, Excel, Outlook versions 2003 to 2007, and Open Office
and their resolutions.
This SIG meets in Science 306 at 9:00 a.m.

From the Desk of the Membership Chairman
By Ben Lochtenbergh, bal@msn.com

The election went well. We now have doctors as president and vice president! We had a slate of eleven nominees thus
one member short, but at the last minute one SIG leader volunteered, so now we have a full board! I took note that all
board members were present. A great start of the new NOCCC club year.
I noticed two or three members with walking difficulties still attending NOCCC meetings and
duties. I’m sure all of us, would like to commend them for their presence and wish them a speedy
recovery!
About the Main Meeting presentation I’d like to say that Bob Dickson did an outstanding job. I
know Microsoft Access quite well and found no flaws in the technical part of his presentation. The
databases he created during his SIG were pleasing to look at and functional to work with. From a
presentation point of view I learned a number of things.
I believe that other members know and have done things computer wise that could be as good as
Bob’s if put into a Main Meeting presentation. Even if it would be half as good as Bob’s it would
still be worth to watch.
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Larry Klees during his first board meeting this time around, he has been on the board before, said: “I don’t understand why
our club lasted this long, there is something special about this club.” I concur, but what is it? We should find out in detail
what it is and use that to attract and increase membership. Can anybody put this special something into words? I’ll be all
ears.

FREE AD SPACE
If you are an NOCCC member, and have a computer-related, non-commercial or “Talent Available” ad that you would
like to have placed in this newsletter or on the NOCCC web site, send an e-mail with a copy of your business card or ad
to the NOCCC Editor at editor@noccc.org .
Your business card would look good here!!!
For information about advertising in the Orange Bytes, contact editor@noccc.org.
NOCCC members Classified ads cost $5 for 1-25 words and $10 for 26-50 words.
Commercial display advertisements are welcome: contact editor@noccc.org.
RATES
One Page Vertical
Half-page Horizontal
Half-page Vertical
Quarter-page
Business Card
Center Spread

7.0” x 9.5”
7.0” x 5.0”
3.5” x 9.5”
3.5” x 5.0”
3.5” x 2.0”
14.0” x 9.5”

$ 150
$ 80
$ 80
$ 45
$ 15 >
$ 300

Deadline: Tenth of the month. Discounts: 3 months=10%, 6=15%, 12=20%. If you are interested in advertising in the
publications of multiple User Groups throughout the region or nationally, you can learn more by contacting
http://www.apcug.org. Readers, please tell our advertisers that you saw their ad in the Orange Bytes.

Transportation Information
Meeting Information
The NOCCC meetings are held at Chapman University, in the Hashinger Science Center and Irvine Hall, near the corner
of Center Street and Palm Avenue.
Parking Information:
Most of this information is on the back cover. For more information, see www.chapman.edu/map/parking.asp. A map of
the Chapman University campus is also available at www.chapman.edu/map/map.pdf .
Bus:
Several Orange County Transportation Authority (OCTA) buses service Chapman University. Route 54 runs East and
West on Chapman Ave. The 59 runs North and South on Glassell Avenue, but doesn’t start early enough for the 9:00 a.m.
SIGs. Get the most current information or use a trip planner at www.octa.net . OCTA also has a Consumer Information
Center at (714) 636-7433 (RIDE).
Railroad: Metrolink trains can get you to the NOCCC meeting from the Inland Empire. There are stops in the cities of
Riverside, Corona, and Anaheim Hills. Parking your vehicle is free at the train station. See M on map below On
Sundays, Inland Empire-Orange County Line train 859 leaves San Bernardino destined for Orange County at 8:55 am.
For the return trip, train 663 leaves nearby Orange Metrolink at 3:11 pm and train 860 leaves at 5:37 pm. The Metrolink
station is four-and-a-half blocks from Chapman University. For specifics regarding your trip, check the web site:
http://www.metrolinktrains.com or call 1-800-371-5465.

Board Meeting Minutes
Monday, July 17, 2012
Sickness and Distress: Steven has regretfully resigned as Club Secretary due to illness. We all wish him a speedy and
successful recovery.
For an alternate set of minutes, click here.
Steven M. Breitbart, P.E.
h) (714) 486-3070
c) (714) 421-1118
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NOCCC Bylaws

The club’s Bylaws are available here: Noccc9-97BylawsAsAmended-1-4-09.pdf

Renewed Members in July 2012 . . .
From Treasurer: TBD

NOCCC Fee Schedule
The fee schedule has been set up to increase club membership, attract people with an interest in computing, and attract local computer-related
businesses to place ads in the Orange Bytes with or without becoming NOCCC members. We are also offering members the opportunity to help
our club financially by making donations that should be income-tax deductible since we are chartered as a non-profit 501(c)(3) organization.
Donors will be acknowledged in the Orange Bytes and the Membership level will be shown on the Member’s Badge. Your regular dues is tax
deductible!
Membership Level ($) 1 Year 3 Years
Individual Member....................................................35.........90
Each Additional Family Member..............................15..........40
Full-Time* Enrolled College Student.....................20
Enrolled High School Student...................................15
*Minimum 12 Semester Hours
Business Member + Ad (Business Card)................180
Business Member + Ad (¼ Page, ½ Page)...............465 , 800
Business Member + Ad (Full Page).........................1,475
Membership Donations ($)
Contributing Member................................................75
Supporting Member...................................................100
Advocate Member.......................................................250
Patron Member...........................................................500

Links to other Computer Clubs
To provide additional information to our members, we are now listing the web addresses of other computer clubs.
Updates from Ted Littman.
Region 10 of APCUG (Association of Personal Computer User Groups)
www.noccc.org
North Orange County Computer Group
www.orcopug.org
Orange County PC Users Group
cugr.apcug.org/
Computer Users Group of Redding
www.thepcclub.org/
Laguna Woods Village PC Club
SCPD-ComputerClub.org
Sun City Palm Desert Computer Club
www.lacspc.org
Los Angeles Computer Society
www.mbug.org
Monterey Bay Computer User Group - PC
www.oakmontpc.com
Oakmont PC Users Group
www.pcc.org
PC Community (Hayward, CA)
pmlcug.org/
Pine Mountain Lake Computer Users Group
www.scvpcg.org
SCV Computer Club (Newhall, CA)
www.topcc.org
Thousand Oaks Personal Computer Club
For all regions, see: www.apcug.net/members/newsletters_index_page.htm

Pig SIG Open to All
Meet us outside Irvine Hall from about noon to 12:30 p.m. There are several benches where NOCCC people gather, eat and chat. Just look for the
member
badges, grab a chair and join in! This is an informal group; so many different subjects are discussed. It’s a great opportunity to mix, mingle, and network!

Free coffee & tea at the July meeting!
Donuts $1/Each & Cookies $.50/Each

No Freebies!
Put your dollars & quarters in the collection can.
All opinions expressed herein are those of the individual authors only and do not necessarily represent the opinions of the NOCCC, its officers,
Board of Directors, the Orange Bytes newsletter or its editors. The NOCCC does not guarantee the accuracy or the correctness of advertising or
articles in the Orange Bytes, nor does the NOCCC intend to endorse, rate, or otherwise officially comment on products available. Therefore, the
readers are cautioned to rely on opinions presented exclusively at their own risk.
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Trademarks/Copyrights — The mention of names of products in this publication without trademark or copyright symbols does not imply that they are
not so protected by law. All trademarks are the property of their respective owners.
Production — Formerly: Orange Bytes was produced with Microsoft Word ® using the True Type fonts Arial, Bauhaus 93, Bodoni, and Times New
Roman. Presently: This version uses HTML - older and newer styles merged together.

Please send e-mail address changes to membership@noccc.org

Browser Notes:
1. Getting a printout of the Orange Bytes page:
Screen layout is 900 pixels width for the body (to emulate original PDF layout decisions). This gives adequate presentation
on a monitor set up for 1024px width. However, this is typically too wide for portrait mode on most printers, i.e. some of the
image will be chopped off. So, in Internet Explorer we typically use "Enable Shrink-to-Fit" for most printout purposes.
(Other browsers have a similar feature.) Per the
image to the left, this is a checkbox under
File -> Print -> Page Setup. This allows full
page rendering. HOWEVER, since everything
gets shrunk, the text becomes smaller and harder
to read. What to do? The font size could be
made larger to make the shrunken text look
larger. But it would also throw off the
pagination code that is partially present.
Solution: A separate CSS style sheet will be
used that just makes the font size larger for
printers. This is a work-in-progress. A
temporary ALTERNATIVE: Use Landscape
mode and disable shrink-to-fit. But that would throw off the portrait-mode pagination code. Oh well . . . For the present,
best to just live with the smaller printout text until the fix comes along.)
2. Regarding Internet Explorer Browsers. There is a major difference between IE8 and IE9. Microsoft has decided to NOT
support IE9 on Windows XP, which many people still use, only Windows 7. Google it for details. From a Javascript
viewpoint, there are enough differences to allow our Pong Game (on Home Page) to work on W7/IE9, but not XP/IE8. We
are working on a "fix", but nothing yet. Yes, the Editor has an XP machine and is frustrated, but the machine doesn't have
enough system requirements to upgrade to W7. It appears to be a plot to force users to upgrade to W7 so only one O.S.
needs to be supported, even though that requires new hardware. However, Firefox and Safari work for Pong, and probably
Opera and Konqueror.

Orange Bytes NewsMagazine Past Issues
The Orange Bytes Newsmagazine is available for downloading and viewing with
Adobe PDF readers. Pick the past issue you would like to view from the list below.
Read a brief tutorial below about Navigating In A PDF Document (in PDF format).

June2012 Issue (0.5 megabytes)
May2012 Issue (0.3 megabytes)
April2012 Issue (1.4 megabytes)
March2012 Issue (1.4 megabytes)
February2012 Issue (1.5 megabytes)
January2012 Issue (1.3 megabytes)
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December2006 Issue (3,132 Kbytes)
November2006 Issue (4,006 Kbytes)
October2006 Issue (1,878 Kbytes)
September2006 Issue (3,211 Kbytes)
August2006 Issue (2,329 Kbytes)
July2006 Issue (3,726 Kbytes)
June2006 Issue (3,363 Kbytes)
May2006 Issue (2,915 Kbytes)
April2006 Issue (1,639 Kbytes)
March2006 Issue (1,728 Kbytes)
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December2011 Issue (5.7 megabytes)
November2011 Issue (5.6 megabytes)
October2011 Issue (4.1 megabytes)
September2011 Issue (2.3 megabytes)
August2011 Issue (6.2 megabytes)
July2011 Issue (1.8 megabytes)
June2011 Issue (1.6 megabytes)
May2011 Issue (1.7 megabytes)
April2011 Issue (1.5 megabytes)
March2011 Issue (1.0 megabytes)
February2011 Issue (1.4 megabytes)
January2011 Issue (1.9 megabytes)
December2010 Issue (1.8 megabytes)
November2010 Issue (2.0 megabytes)
October2010 Issue (1.2 megabytes)
September2010 Issue (2.3 megabytes)
August2010 Issue (1.2 megabytes)
July2010 Issue (1.6 megabytes)
June2010 Issue (1.4 megabytes)
May2010 Issue (1.3 megabytes)
April2010 Issue (1.8 megabytes)
March2010 Issue (1.4 megabytes)
February2010 Issue (1.2 megabytes)
January2010 Issue (1.1 megabytes)
December2009 Issue (1.2 megabytes)
November2009 Issue (1.3 megabytes)
October2009 Issue (1.1 megabytes)
September2009 Issue (1.2 megabytes)
August2009 Issue (1.3 megabytes)
July2009 Issue (1.7 megabytes)
June2009 Issue (1.2 megabytes)
May2009 Issue (1.1 megabytes)
April2009 Issue (1.0 megabytes)
March2009 Issue (1.3 megabytes)
February2009 Issue (2.3 megabytes)
January2009 Issue (1.1 megabytes)
December2008 Issue (1.9 megabytes)
November2008 Issue (1.1 megabytes)
October2008 Issue (1.4 megabytes)
September2008 Issue (1.1 megabytes)
August2008 Issue (1.4 megabytes)
July2008 Issue (1.01 megabytes)
June2008 Issue (1.06 megabytes)
May2008 Issue (1.33 megabytes)
April2008 Issue (1.84 megabytes)
March2008 Issue (1.04 megabytes)
February2008 Issue (1.24 megabytes)
January2008 Issue (1.17 megabytes)
December2007 Issue (1.6 megabytes)
November2007 Issue (904 kilobytes)
October2007 Issue (4.6 megabytes)
September2007 Issue (0.913 megabytes)
August2007 Issue (0.931 megabytes)
July2007 Issue (1.998 megabytes)
June2007 Issue (1.91 megabytes)
May2007 Issue (2.23 megabytes)
April2007 Issue (2.19 megabytes)
March2007 Issue (2.27 megabytes)
February2007 Issue (4.81 megabytes)
January2007 Issue (2,154 Kbytes)

February2006 Issue (1,752 Kbytes)
January2006 Issue (1,834 Kbytes)
December2005 Issue (1,924 Kbytes)
November2005 Issue (1,042 Kbytes)
October2005 Issue (1,100 Kbytes)
September2005 Issue (2,478 Kbytes)
August2005 Issue (1,022 Kbytes)
July2005 Issue (1,842 Kbytes)
June2005 Issue (1,262 Kbytes)
May2005 Issue (1,500 Kbytes)
April2005 Issue (987 Kbytes)
March2005 Issue (2,084 Kbytes)
February2005 Issue (2,070 Kbytes)
January2005 Issue (1,690 Kbytes)
December2004 Issue (2,449 Kbytes)
November2004 Issue (1,146 Kbytes)
October2004 Issue (1,169 Kbytes)
September2004 Issue (1,185 Kbytes)
August2004 Issue (2,013 Kbytes)
July2004 Issue (1,572 Kbytes)
June2004 Issue (1,289 Kbytes)
May2004 Issue (1,231 Kbytes)
April2004 Issue (1,156 Kbytes)
March2004 Issue (1,384 Kbytes)
February2004 Issue (1,942 Kbytes)
January2004 Issue (1,460 Kbytes)
December2003 Issue (1,492 Kbytes)
November2003 Issue (2404K)
October2003 Issue (1373K)
September2003 Issue (1455K)
August2003 Issue (2187K)
July2003 Issue (11804K)
June2003 Issue (1024K)
May2003 Issue (957K)
April2003 Issue (1050K)
March2003 Issue (668K)
February2003 Issue (1031K)
January2003 Issue (1470K)
December2002 Issue (1064K)
November2002 Issue (1546)
October2002 Issue (1137K)
September2002 Issue (1139K)
August2002 Issue (306K)
July2002 Issue (186K)
June2002 Issue (873K)
May2002 Issue (388K)
April2002 Issue (377K)
March2002 Issue (355K)
February2002 Issue (336K)
January2002 Issue (615K)

Read a brief tutorial here about Navigating In A PDF
Document (in PDF format).

End Notes
Meeting Information — The NOCCC meeting is held at Chapman University, in the Hashinger Science Center and
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Irvine Hall, near the corner of N. Center St. and E. Palm Ave., which is in the s outheast corner of the campus.
Parking Information - Chapman University’s main parking lot is the underground Lastinger Parking Structure under
Wilson field on the north side of the campus. Enter from Walnut Avenue, just east of Glassell Street. Parking is not free
on Sunday, even if the gate is up. However, the permit vending machine is about 100 feet south of the entry area. There
are other machines elsewhere in the lot. Find one, buy a permit, and put it on your dashboard. Do not park in any other
lot, in a reserved space, or back into a space.
Free street parking also is available on the campus-side of the streets only. Parking in front of any residential housing will
result in an expensive parking ticket. A City of Orange public parking lot, located on the southwest corner of E. Maple
and N. Orange, is also free and only 2 blocks from the meeting. For more information, see the Transportation Information
section.
North Orange County Computer Club
PO Box 3616
Orange, CA 92857
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